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INTRODUCTION                                                                                                STL ControlHub
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ControlHub is an all-inclusive mixing plugin that allows you to load entire signal chain-based expansion packs from 
your favorite mixers and recording studios. This is not another channel strip plugin, but a complete emulation of the 
original hardware or software signal chain. 
 
You now have the power to mix your individual tracks, mix bus, and master chains using complete signal chain 
emulations from world-class mixing engineers. 
 
Accelerate your workflow, without compromising your creativity.
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SYSTEM REQUIREMENTS                                                                               STL ControlHub

ControlHub comes in 64-bit VST / AU / AAX / Standalone and is compatible with the latest OS for Windows & Mac.
Minimum requirements Mac OS 10.9 or Windows 7 (64-bit).

 of 5 43



SUPPORTED HOST SOFTWARE                                                                     STL ControlHub

To use STL Tones software you need audio software which can load “plugins”. You can also run STL Tones software 
as a Standalone application. This plugin officially supports the following software host: 

Pro Tools 2021.12.0: Mac & PC: AAX Native

Logic Pro 9 & 10 (X): Mac: Audio Units

Cubase 9 & 10: Mac & PC: VST

Ableton Live 9 & 10: Mac: Audio Units & VST; Windows: VST 

Reaper 5.x: Mac: AU & VST; Windows: VST.
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iLok User ID & License Manager                                                                     STL ControlHub

STL Tones User Account
In your STL Tones User Account, you will have access to your product installers, and latest software updates. To login 
to your user account, go to http://www.stltones.com and click the ‘Login’ button in the upper right-hand corner of the 
window. If you don't have a user account, please create one by clicking ‘Create Account’ inside the same login 
window. Please note, by purchasing a product with STL Tones, you aren’t automatically assigned a user account, you 
need to manually sign up in order to have access to your downloads and logging in. 

License Location
• In your STL Tones account you will have 

access to your product installers and 
latest updates. By clicking your product 
download link, a new window will open 
that will show your Activation License 

• To login into your user account, go to 
http://www.stltones.com and click on the 
“Login” button in the upper right- hand 
corner. If you don’t have a user account, 
create one by clicking “Create Account” 
inside the same login window.
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Please create an iLok account by 
visiting http://www.ilok.com and 
download the latest version of the iLok 
license manager application. This will 
allow you to register your serial number 
and deposit your license to your 
computer or an iLok USB key. NOTE:- 
You DO NOT need an iLok USB 
Dongle in order to use this plugin. 
You can simply register your iLok 
license code to your computer that 
you intend to use the plugin on. 

Install the iLok License Manager, 
open the program on your computer, 
and sign in with the iLok User ID 
information that you created at http://
www.ilok.com. When logged in, a list of 
available destinations for license 
placement will be displayed under your 
User ID, such as your computer, or your iLok USB Keys. A list of all currently activated products will be shown in the 
main right list window. Inactive licenses will be shown in the “available” tab on the top. 

You can drag and drop licenses to deposit them in your computer or iLok USB Keys. 
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INSTALLATION & License Activation                                                              STL ControlHub

Run the provided installer which you will receive via email, follow the on-screen instructions given by the installation 
software. NOTE: both PC and Mac installers are provided within in the same folder. 

License Activation
The plugin won't be functional until you activate it 
with a valid iLok license. 

Follow these steps to complete the software 
activation. 

STEP 1 - 

After logging in to your iLok Account, click on the 
“Activate” button and go through the process to 
authorise your software.
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STEP 2 - Enter your activation code and if 

valid, green ticks will appear, as seen in the 

image below. 
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STEP 3 - Sign in to your iLok user account. If you haven’t yet 

created one, click on the ‘Create new account’ link, and you 

will be directed to ilok.com to create an account, which is 

free. 

STEP 4 - Here you will see all available locations to place 

your license. Select either your computer, iLok Cloud, or iLok 

USB key.  
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STEP 5 - Successful Activation window will appear, confirming 

you have registered your product correctly.  
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EXPANSION PACK INSTALLATION & License Activation                             STL ControlHub

Step 1: download your 
ControlHub Artist 
Expansion pack 
installer that is sent to 
you via email. Both PC 
and Mac versions are 
in the same 
downloaded folder.  

Step 2: run the 
Expansion Pack 
installer. 

Step 3: If your DAW is 
currently open, close 
the daw. 

Step 4: Open iLok 
License Manager and 
click the Sign In button 
on the top left. 
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Step 5: locate your 
activation code which 
is sent to you via 
email. 

Step 6: Click the two 
dots up the top right-
hand corner within 
iLok License 
Manager. 
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Step 7: Once your 
code has been 
entered, click the 
Next button. 
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Step 8: select where 
you would like to 
activate your 
Expansion Pack to. 
Here you can select 
to activate to your 
computer, iLok Cloud, 
or your physical iLok 
USB dongle.

Step 9: Open your 
DAW, and your pack 
will now be readily 
available to use within 
the STL ControlHub 
plugin. 
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USER INTERFACE                                                                                            STL ControlHub

1. ControlHub menu: Access the Artist Expansion Packs, saved user banks in the Local Library tab, and the STL 
Shop where you can purchase the latest expansion packs. The Settings tab has customizable user options for the 
plugin.

2. Preset browser displaying the hardware/software used in the selected preset’s signal chain.

3. Undo & Redo: Located in the left corner of the Analyzer window are the Undo/Redo buttons, allowing for quick 
recall of previous settings or redoing a move.

4. Resize: Located in the top left corner are the resize arrows for the plugin interface. This lets you quickly change the 
size to three possible values: 50%, 75% and 100%. In addition to these 3 modes, you can fine-tune the size using the 
resize function in the bottom right corner of the plugin by clicking and dragging.
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5. Graphical EQ/Spectrum Mode & Waveform/Gain Reduction Window: Spectrum mode displays the spectral content 
of the audio being processed by ControlHub, allowing you to visually analyze what's happening in your mix whilst in 
EQ mode, you have both precise feedback on the processing and control of the EQ modules. The waveform view 
represents the processed audio in a more familiar DAW style waveform with the gain reduction applied by the Limiter 
module within ControlHub shown with a blue gain reduction line.

6. Analyzer Settings: The gear button allows you to manage options related to the linear spectrum analyzer. The two 
buttons to the right allow you to toggle between the spectrum and waveform views. 

7. Routing: Selects the processing mode of the plugin (Mono, Mono/Stereo, or Stereo). Stereo Mode will double the 
CPU load of the plugin, as the two audio channels are being processed by two separate instances of the plugin. 

8. Input Slider: Adjusts the input level of the plugin. Changing the input will affect the gain staging of the individual 
modules, so you may have to readjust the Compressor threshold settings for example based on the audio you are 
processing.

9. Output Slider: Adjusts the output level of the plugin. This slider is placed after the Limiter allowing it to be used for 
level matching or make-up gain.
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10. Global Stereo Controls: This allows the user to 
switch between Stereo (L/R) processing or Mid/Side (M/
S) processing. 

The Balance control function changes depending on the 
mode selected, with L/R adjusting the basic stereo 
balance and M/S allowing to you adjust the mono/
stereo information on your track. 

The Link parameter controls the amount of gain reduction being applied to the compressor and limiter, with 100% = 
equal compression on both channels. 0% = L/R channels compression is independent of one another.

11. Mix: Controls the amount of unprocessed signal being blended with the processed signal, giving you the option of 
parallel processing. 100% = you’re hearing the entire processed signal. 0% = you’re hearing only the raw signal.

12. Phase Invert button inverts the polarity of the audio signal.

13. Pre & Master: Located in the bottom left corner of the Analyzer window are the Pre/Master EQ buttons, allowing 
for quick switching control between the Pre & Master EQ modules in graphical EQ mode.
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PRE & MASTER EQUALIZER MODULES                                                        STL ControlHub 

1. High-Pass Filter: Turn on/off with a single click on the LED. Clicking 
the selectable slope button (dB/oct) shows the filter options in the 
dropdown menu.
2. Low-Pass Filter: Turn on with a single click on the LED. Clicking the 
selectable slope button (dB/oct) shows the filter options in the dropdown 
menu.
3. Both Pre and Master EQ modules have 3 full sweepable bands that 
range from 20Hz - 22kHz. The Q bandwidth is selectable, ranging from a 
low shelf (far left) through to a high shelf (far right) allowing subtle tone 
shaping or surgical equalization. Tip: Double-click to reset the 
parameter. Right-click to manually enter a specific Hz value. Holding 
Command ⌘ whilst scrolling allows for precise tuning of the Hz control.

4. Power On/Off button for the Pre EQ module.

NOTE: All modules have a dedicated power on/off button in ControlHub. 
Engage the modules by clicking the on/off button (illuminated when 
engaged) and simply re-click to bypass the module entirely.
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Graphical EQ Mode                                                                                           STL ControlHub

NOTE: Engaging the power On/Off button on either Pre or Master EQ will enable the EQ mode functions. The EQ 
mode’s graphical display is tied to the module that is being adjusted, instantly switching so you always know what 
module is being changed.

1. High-Pass Filter: Turn on/off with a double-click on the filter’s circle. Right-click and holing whilst dragging up/down 
will change the selectable slope (dB/oct) filter.

2. Low-Pass Filter: Turn on/off with a double-click on the filter’s circle. Right-click + hold whilst dragging up/down will 
change the selectable slope (dB/oct) filter.
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3. Frequency Bands: Both Pre and Master EQ modules have 3 full sweepable bands that range from 20Hz - 22kHz. 
Turn each band on/off with a double-click on the frequency curve circle. Right-click + hold whilst dragging up/down 
will cycle through the selectable Q bandwidth for broad tone shaping or surgical precision. The Frequency being 
adjusted and the amount of boost/cut (dB) is displayed above the curve circle for a faster workflow.

4. Pre & Master: Selectable buttons for quick switching between the Pre & Master EQ modules from the spectrum 
view window. Note: When an EQ module is bypassed, the text will be white. When engaged, the text is blue which 
also indicates which module is currently displayed.

5. EQ dB meter: Displays the frequency bands dB value (+/- 15dB).
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COLOR MODULE                                                                                              STL ControlHub

1. VOLUME control for the preamp section of the color module. This will 
affect the amount of saturation the color section is providing as you will 
be driving more or less level into the Drive, Tape and Tube circuits.

2. BASS shelving filter EQ with a center frequency at 100Hz allowing for 
subtle low-end control.

3. TREBLE shelving filter EQ with a center frequency starting at 5kHz to 
help shape a tracks high-end.

Note: The preamp EQ works before the Color saturation circuits. The 
signal is split and goes through the Tube and the Tape effect in parallel 
allowing a mix of both saturation colors.

4. The DRIVE circuit is modelling preamp-style distortion.

5. The TAPE control features a sub to lower midrange EQ bump and is 
more aggressive in its distortion character when driven hard.

6. The TUBE control uses two cascaded stages, making for a very 
transparent saturation texture. Increase the Drive control to push more 
level into the Tube circuit for more deliberate creative distortion effects.

7. Power On/Off button for the Color module.
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COMPRESSOR MODULE                                                                                 STL ControlHub

1.FET or VCA style compression selection buttons.

2. THRESHOLD control sets the level at which the compressor begins 
to attenuate the signal. This level is related to the ratio setting.

3. MAKEUP gain allows you to manually match of the input levels to the 
output levels once the signal is being attenuated.

4. AUTO MAKEUP GAIN LED will automatically compensate for the 
level reduction caused by the compressor. NOTE: MAKEUP control 
greys out to indicate AUTO MAKEUP mode is engaged.

5. ATTACK controls how fast the compressor reacts to the incoming 
signal.

6. RELEASE controls how long the compressor holds the signal before 
returning to an uncompressed state.

7. RATIO determines how much gain reduction the signal above the 
given Threshold will be compressed. NOTE: The VCA style module ratio 
is displayed as a percentage.

8. SIDECHAIN controls a high-pass filter for the Compressors input 
detection circuit.

9. INPUT controls the signal level going into the compressor.
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10. MIX controls the amount of uncompressed signal being blended with 
the compressed signal, allowing the option of parallel processing. 100% 
= you’re hearing the entire compressed signal. 0% = you’re hearing only 
the uncompressed signal.

11. KNEE (VCA mode only) controls how the compressor transitions 
between the uncompressed and compressed audio signal. 0dB = soft 
knee style. 30dB = hard knee style.

12. AUTO (FET mode) changes the release time to be dependent upon 
the duration of the program peak.

13. Click to select automated release operations (VCA mode only).

14. Gain reduction meters show the amount of attenuation (measured in 
dB) being applied by the compressor.

15. Power On/Off button for the Compressor module.
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EFFECTS MODULE                                                                                           STL ControlHub

DELAY

Two delay units have been modelled for ControlHub covering time-
based effects used in every mix to create movement and depth all the 
way to vintage style analog echos with textured lofi options. Currently, 
there are 17 different Delay Types. 

1. ON/OFF symbol (top right corner) of the LCD screen engages the 
delay effect. You can also engage the effect by double-clicking the 
DELAY text on the LCD screen. The arrows allow you to cycle to the 
REVERB effects (see REVERB below for more information) 

2. UNIT displays the delay model currently being used. Click on the 
UNIT text to bring up the menu displaying the delay units available. You 
can use the arrows left/right to scroll through the different types for quick 
auditioning.

3. TYPE displays the current style of delay being used. Click on the 
TYPE text to bring up the menu displaying the delay variations available. 
You can use the arrows left/right to scroll through the different types for 
that selected UNIT for quick auditioning.

4. TIME shows the delay time value in milliseconds (ms) by default. 
When the BPM SYNC LED is engaged the delay time is displayed in 
note values synced to the DAW. Clicking on the note values in the LCD 
effects screen cycles through these musical note values or you can use 
the TIME control knob to quickly dial in the amount of delay is needed.
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5. MIX controls the amount of delay effect being blended with the 
original signal. 100% = you’re hearing only the processed signal. 0% = 
you’re hearing only the original signal.

6. F.BACK controls the amount of delay feedback repeats.

7. DEPTH controls the modulation depth of the delay repeats from 
0-100%.

8. RATE controls the modulation rate of the delay repeats from 0Hz 
to5Hz.

9. HIPASS EQ filter controls the EQ of the delay repeats from 10Hz to 
5000Hz.

10. LOPASS EQ filter controls the EQ of the delay repeats from 22kHz 
to 5000Hz.

11. BPM SYNC allows the delay to tempo synchronize with the host 
DAW.

12. PING PONG creates a stereo effect (mono/stereo routing required) 
of the delay signal bouncing between the left and right channels.

13. Power On/Off button for the EFFECTS module.
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REVERB

Seven reverb units have been modelled for ControlHub with 55 different 
types at your fingertips, giving you access to everything from tight short 
room sounds to ethereal chambers.

1. ON/OFF symbol (top right corner) of the LCD screen engages the 
reverb effect. You can also engage the effect by double-clicking the 
REVERB text on the LCD screen. The arrows allow you to cycle to the 
DELAY effects (see DELAY above for more information).

2. UNIT displays the reverb model currently being used. Click on the 
UNIT text to bring up the menu displaying the reverb units available. You 
can use the arrows left/right to scroll through the different types for quick 
auditioning.

3. TYPE displays the current style of reverb being used. Click on the 
TYPE text to bring up the menu displaying the reverb variations 
available. You can use the arrows left/right to scroll through the different 
types for that selected UNIT for quick auditioning.

4. TIME sets the size of the reverb selected. You can use the arrows left/
right to scroll through the different sizes (SHORT, MEDIUM & LONG) for 
that selected UNIT for quick auditioning.

5. MIX controls the amount of reverb effect being blended with the 
original signal. 100% = you’re hearing only the processed signal. 0% = 
you’re hearing only the original signal.
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6. PRE DELAY determines the amount of time before the reverb begins.

7. LENGTH allows you to change the length range of the selected 
reverb time to further shape the reverb decay.

8. DEPTH controls the modulation depth of the delay repeats from 
0-100%.

9. RATE controls the modulation rate of the delay repeats from 0Hz 
to5Hz.

10. HIPASS EQ filter controls the EQ of the delay repeats from 10Hz to 
5000Hz.

11. LOPASS EQ filter controls the EQ of the delay repeats from 22kHz to 
5000Hz.

12. Power On/Off button for the EFFECTS module.
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LIMITER                                                                                                             STL ControlHub

1. THRESHOLD control sets the level at which the Limiter begins to 
attenuate the signal. Set the threshold of the limiter by dragging the 
slider down. When the threshold is exceeded by the signal, you will see 
the gain reduction indicated in the stereo attenuation meters to the left 
and right of the Ceiling slider.

2. CEILING sets the output level of the Limiter. The default 0.0 dB is 
your maximum peak output.

3. RELEASE controls how long the Limiter holds the signal before 
returning to an uncompressed state.

4. The LINK button couples the Threshold and the Ceiling sliders in their 
current position. Helpful when wanting to control the dynamic of a signal 
without increasing the volume.

5. Power On/Off button for the LIMITER module.

NOTE: The Limiter has a fixed attack time of 1ms with a 1.2ms look-
ahead detection time.
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ARTIST EXPANSION PACKS                                                                            STL ControlHub

1. ControlHub Artist Expansion packs are located in the Artist Packs folder of 
the menu. Once a preset is selected from the dropdown menu, it will load 
each module and display the signal chain used in the preset browser. You 
can change presets from both the Artist Packs folder & the browser.

2. Presets are organized in the following categories: 

• Drums

• Bass

• Guitars

• Vocals

• Keyboards/Synths

• Orchestral

• Mix Bus/Master

• Effects

• Individual Models

• Misc
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3. Toggle through different presets within a category by using the left/right arrows for quick auditioning.

NOTE: All presets within an official ControlHub Expansion pack are editable, however they will default back to the 
artist's original settings if not saved to your own bank. For example, if you edit a preset, and click on another preset, 
the settings will not be saved automatically. Please see the ‘Preset Manager’ section below for more information on 
how to save and edit presets.
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PRESET MANAGER                                                                                          STL ControlHub

Manage the ControlHub default and user settings by clicking 
on the Local Library dropdown menu. The Preset manager is 
divided into 3 sections: Local Library, Edit and Create. 

1. Under the Local Library section you’ll find all the available 
banks where each bank entry has a submenu featuring all the 
presets it contains.

2. Use the + icon to bring up the Edit and Create options.

3. Under the Edit section you can tweak the currently loaded 
preset or bank. NOTE: A bank is a group of presets that can 
be imported or exported as files, in order to save or recall 
settings or to move them from one DAW to another.

4. Under the Create section you can add a preset to the 
current bank or create a new bank entirely. When creating a 
new bank, the currently loaded preset will be copied into it 
however you can adjust/delete this using the Edit options 
after the fact.
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Tip: If you want to rapidly copy some settings from one instance to another inside a DAW project, you can use the 
Edit > Current Preset > Copy function. This will store the settings in the clipboard, so you can move into your second 
instance and select Edit > Current Preset > Paste to paste the stored settings.  
Keep in mind that settings in the clipboard are preserved until there is at least 1 instance of ControlHub available. If 
you close all the instances and open a new one later, the clipboard will be cleared out and you won’t be able to paste. 
It is also worth noting that Copy/Paste only works between plugins of the same format

NOTE: Banks and Preset files are located on your local drive. See below for locations. Mac - Users/Documents/STL/
ControlHub/Banks PC - C:\Users\Documents\STL\ ControlHub\Banks
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SETTINGS                                                                                                          STL ControlHub

1. Manage the SETTINGS for ControlHub.

2. The APPEARANCE tab lets you change the color scheme 
for the plugin. Chose between Dark & Light modes.
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SUPPORT                                                                                                          STL ControlHub

 For technical issues or any problems experienced with our software contact us via the contact page at  
www.stltones.com. Before doing so, follow our Troubleshooting questions below to see if these fix your issue. 

Support Information to be provided

In order to help us assist you in the best way possible, please provide the following information to our support team:

• Product Version Number (e.g STL ControlHub - V1.0.0.) 

• Version number of your DAW (e.g ProTools 11.2.2, Logic 10.2.4) 

• Interface/hardware (e.g. Focusrite Scarlett 2i2, Universal Audio Apollo Twin, etc.) 

• Computer and operating system info (e.g Macbook Pro OS X 11.5.1, Windows 10 ver 1709, etc.)

• Please include a detailed description of your problem.
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TROUBLE SHOOTING                                                                                      STL ControlHub

Having issues with our software? 
Uninstall / Reinstall
This will repair possible broken permissions, fix corrupted files, and remove old versions of our software

Steps:
1) Close out of all host software (Pro Tools, Logic, Cubase, etc.)
2) Uninstall your plugin.
3) Open your host software and ensure that the plugins no longer showing up in the inserts list. If the plugins are still 
present, locate the files on your computer and remove them manually. Once they no longer show up in your DAW 
(after restarting it), move on to step 4.
4) Close out of all host software.
5) Download the latest iLok License Manager application from iLok.com, install it, run the program and login with your 
iLok credentials.
6) Log into your STL Tones User Account and download the latest installers for the plugin.
7) Run the latest installers and start your host program.
8) To confirm, ensure that your host program is reading the latest version of our software.

iLok synchronisation:
If you receive a message telling you to activate your licenses again, follow these steps.

Fix iLok connectivity:
If your iLok cannot connect to your computer, try plugging it in through a powered USB 2.0 hub – this will increase the 
likelihood that the iLok will connect to the computer. Once it is synched, it should be able to be plugged back into the 
computer’s USB port for use.
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Repair your computer’s hard-drive:
Repair permissions on your computer.
Instructions: Mac & Windows

Run your host software as an administrator (Windows-only) :
This can fix a variety of issues that result in crashing or error messages on Windows DAWs that are loading our 
plugins for the first time.

Steps:
1) Exit your host program (Pro Tools, Cubase, etc.)
2) Right-click on the icon for that host program and select “Run as an Administrator.” You will only have to do this 
once, meaning you can open up the host program normally the next time.

How do I find my plugin in Reaper?
If cannot find your STL ToneHub plugin in Reaper, follow these steps in order to make the plugin available.
Step1:
Download and install the latest version of iLok License Manager from iLok.com. After you install, open it and login 
with your iLok credentials. If you don’t have an iLok account, please create an account for free at iLok.com.
Step2: 
Now check if the plugin is installed on your computer in the default folder.

File Locations: MAC
VST: Macintosh HD/Library/Audio/Plugins/VST/STL ControlHub

File Locations: Windows
64-bit VST: C:\Program Files\VSTPlugins\STL ControlHub
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If you don’t find the respective files please reinstall your STL ControlHub Product. If the relevant plugin files are in the 
above folder, perform a rescan:
In Reaper, press [Ctrl] + P (Windows) / [Cmd] + [,] (Mac) to access Preferences.
Go to Plugins > VST.
Under “VST Plugin Path,” make sure that the following path is listed (if not, add it):

Windows:
64-bit VST: C:\ Program Files \ VSTPlugins \ STL ControlHub
Mac:
System HD > Library > Audio > Plugins > VST
Click on Clear Cache/Re-Scan. Create a new session with a supported sample rate, add a track and load your STL 
ControlHub plugin. If the pop-up window tells you to activate please press “activate” button and insert your Full 
license serial code.

How do I find my plugin in Pro Tools?
If you cannot find your STL ControlHub plugin in Pro Tools, follow these steps in order to make the plugin available.
Step1: download and install the latest version of iLok License Manager from iLok.com. After install, open it and login 
with your iLok credentials. If you don’t have an iLok account, please create an account for free at iLok.com.

Step2: check if the plugin is installed on your computer in the default folder.

VST: Macintosh HD / Library / Audio / Plugins / VST / STL ControlHub
AAX: Macintosh HD / Library / Application Support / Avid / Audio / Plugins /STL ControlHub

File Locations: Windows
64-bit VST: C:\Program Files\VSTPlugins\STL ControlHub
64-bit AAX: C:\Program Files\Common Files\Avid\Audio\Plugins\STL ControlHub
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If you don’t find the respective files please reinstall your STL ControlHub Product. If the relevant plugin files are in the 
above folder, perform a rescan:
To do a Rescan you need to delete certain files on your computer depending on your Pro Tools version. Please follow 
the official Avid website to do this.

Authorization Exception Error Message:

If this error message pops up, follow these steps:
Close your DAW (Pro Tools, Logic, etc.)
Go to iLok.com and download the latest version of the iLok License Manager application.
Run the iLok License Manager installer on your computer.
Restart your computer.
This issue only affects users who have not installed iLok License Manager 4.0.3 or later.

The plugin makes no sound at all, why is this happening? 

You have most likely not activated the software yet, or the license file has moved to a different location and the 
software can’t find it anymore. Please check the license activation window and double check that it still says you are 
registered. If not, simply redo the steps mentioned in the License Activation chapter.

Where do I find the installers?

You can download your plugins from your STL Tones account. Your account will display the installers and serial 
numbers for all of the STL Tones products you have purchased.

Where is the STL ControlHub Plugin located on my computer? 

Mac:

AudioUnits: Macintosh HD / Library / Audio / Plugins / Components / STL ControlHub
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VST: Macintosh HD / Library / Audio / Plugins / VST / STL ControlHub

AAX: Macintosh HD / Library / Application Support / Avid / Audio / Plugins / STL ControlHub

Windows:

64-bit VST: C:\ Program Files \ VSTPlugins \ STL ControlHub

64-bit AAX: C:\ Program Files \ Common Files \ Avid \ Audio \ Plugins \ STL ControlHub
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LEGAL DISCLAIMER                                                                                         STL Controlhub

All names of gear and/or accessory brands are trademarks owned by their respective manufacturers and are in no 
way affiliated with STL Tones or ControlHub. Product names are simply used for the purpose of identifying the 
hardware chain that was used to create the digital presets.
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